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What is WineBase for Windows? 1.1

Overview WineBase for Windows is a data base system designed with a specific task in
mind. That task, is not only to make keeping track of the wines in your cellar
easier,  but to provide you with information that  no other Cellar Management
System program can. In a form that's easy to understand.

With the addition of Winery Files, Winery information, Regional information,
Maps and the GoldBook, the program also becomes an excellent reference tool.

The program isn't limited to set lists of Wineries, Varieties or Regions. It grows
as your cellar does. You do not have to customise this program to suit the wines
available in your region or the wines you collect. It does it for you.

I don't like typing. To be more correct,  I don't mind typing several  thousand
lines to write a program, but I really dislike typing in data that I have already
got somewhere else in a database. 

If you collect wines from only thirty different Wineries, once you have entered
those thirty, you will never have to type them in again. Not to add new wines
from that Winery, or modify an existing file, not even to search for that Winery
or the wines it makes.

This is a Mouse orientated Database. Menus and List Boxes reflect the current
format  and contents  of  your cellar,  and they grow as  your cellar  does.  You
simply click on what you want.

As the  name  of  an  application  is  mentioned  ofter  in  a  User  Guide,  and  as
WindeBase for Windows is rather lengthy, from here on we will refer to the
program as WBfW.

Features WBfW produce's detailed sorted lists (you choose the sort order) to screen or
printer.  You  can  search  on  any  of  eight  fields  including  Vintage,  Winery,
Label, Variety, Region, Location, Comment as well as Health. Both single and
multiple field search's are provided. Five Graphs and four Tables provide easy
to  read  information  on  all  aspects  of  the  cellar.  A one  page  report  screen
graphs the overall Maturity of the Cellar, as well as all totals and average age.
The size and value of your cellar is plotted against time and will continue to do
so until  the  year  AD 2012 ( by which  point  the  program would have  been
extended to 2032).

Limits WBfW can store information on 1200 different wines (per file), and keep track
of the last eight transactions (bottles coming and going, price changing) for that
wine.  Eight lines of General  Notes and another  eight lines of Tasting Notes,
with dates that you can search on (future dates that is, to remind you to taste a
wine at a certain date). 

Needs This  is  a  Windows  based  program,  so  you  will  need  Microsoft  Windows
version 3.1 I make the assumption that you have a computer capable of running
Windows well. ie. at least a 386SX with 4Mb of memory. The program uses
900K of memory and about 3.5Mb of hard disk space. Running a disk cache
will improve performance considerably.

Whilst the program will run in standard VGA mode (640 X 480) or SVGA (800
X 600), it is written for XVGA (1024 X 768), and looks its best when run at
this  resolution.  Like  all  Windows  programs,  the  better  your  computer,  the
better WBfW will run.



Program Structure 1.2

Overview The program is laid out in much the same way as a book is.

CONTENTS The Front of the Book.

The main window which ties the program together. 

INDEX The Back of the Book.

The results of any search are listed to this scrollable screen.

PAGE DISPLAY The Pages in between.

Detailed information for a wine selected from the INDEX.

A diagram that hopefully shows how the different parts of WBfW fit together.

 



WineBar 1.3

A WineBar? At the top of the screen,  below the Menu is a row of buttons that
perform  the  most  commonly  used  WBfW  functions.  Various
software manufactures have called these rows of buttons all sorts of
things  (SpeedBar,  ToolBar  etc,  and  usually  trade  marked).  In
keeping with the nature of this product,  I have decided to call  the
row of buttons, a WineBar.

There are in fact,  two WineBar's. The first one has the Editing and
Search functions on it,  the second contains all  the Graphs,  Tables,
Reports and Maps.

We will call these the Main and Graph WineBar's.

Main WineBar

1 Going around in circles Swaps the WineBars (applies to both)

 
1 2 3 4 5 6 7 8 9 10 . .14 15 16 17 18 19 20

2 Lines of Text List all Wines in Cellar 11 Green Bottle List all Young Wines
3 Look / Screen Search and Sort options 12 Cyan Bottle List all Improving Wines
4 Coloured Squares Multiple Field Search 13 Yellow Bottle List all Mature Wines
5 Plus Sign Add a new Wine to Cellar 14 Red Bottle Wines turning to vinegar
6 Bottle Search by Stock Level 15 Floppy Disk Backup Data Files
7 Pouring Bottle All Wines good to drink now 16 Clock/Calendar Preferences Dialog
8 Arrow List all 'At Best' in future 17 The World Winery to Region Data
9 Tasting Glasses List all wines due for tasting 18 Gold Book The GoldBook for WBfW
10 Blue Bottle List all 'Non Vintage' Wines 19 Information What all the buttons do

20 Question Mark Help

Graph WineBar

 1 2 3 4 5 6 7 8 9 10 11   12 13 14 15 16 17 18 19 20 21

2 Bar Graph Health Report 12 Bar graph / Grapes BestAt by Variety
3 Bottle and Dollar Value and Stock report 13 A Winery Winery Distribution
4 Squiggly Lines Ageing Graph 14 Scenic Landscape Region Distribution
5 Horizontal Bars TimeLine 15 Grapes Variety Distribution
6 Label and Hourglass  'Label' vs 'Health' Table 16 Blue W Wines only
7 Label and Bottle  'Label' vs 'Bottles vs Vintage 17 Blue and Cyan + Wines and Bottles
8 Grapes and a V Variety vs Vintage vs Bottles 18 Cyan B Bottles only
9 Grapes and a B Variety vs BestAt vs Bottles 19 Printer Print the current Graph
10 Bar Graph Vintage Distribution 20 Map of the World Display Map List
11 Bar Graph 'Best at' Distribution (ALL) 21 Map of Australia Australian Reference map

Status Line At the bottom of the screen is a Status Line which shows from left to
right the following information 

 

· What screen your looking at "Contents"
· What Cellar File you are using "Your Cellar"
· How many wines in this Cellar "182 Wines"
· The Sort Order for Index listings "Sort by Winery"
· The Date "Saturday, 31 July 1993"



Options / Preferences / Fonts 1.4

Currency and Date You can set the program up to work with any Currency and the more common
Date formats by using this Dialog box. It is found in the Options menu under
Preferences.

'User1' and 'User2' These fields can be defined by you. Suggestions are Type (ie Red, White etc),
Food, Index Number, Shipper, Ranking etc. As an added bonus you can Search
and Sort on these fields.

See also Section 5.6 Being Creative.

Transactions WBfW  tracks  all  changes  to  the  main  data  file  on  a  monthly  basis  in  a
Transaction file. This file includes a Reference field (supplier, cheque number,
order  number,  invoice  etc).  With Always  Prompt  for  Reference on  (the
default is off), whenever a wines stock level changes (or a new wine is added)
you will be prompted to enter a reference note.

Dialog Background Colour By default  the program uses Gray Dialog Boxes,  but  you can select  7 other
colours. Click on 'Show Colour' to see what they look like. Candy, Ice and Sky
are my favourites. These are the new Borland Dialog Boxes, which are much
smarter looking than the standard Microsoft ones.

Screen Type There is now support  for LCD Mono Screens.  You have to Exit  WBfW and
restart the program to make this change take effect.

Variety The Main Edit Window includes a default list of Varieties. If you do not wish
to  use  these,  select  'Your  File  Only'.  This  way  WBfW  will  use  only  the
varieties that are in your cellar. 

Use Default Values This button resets all entries to the default settings.

 

Fonts The program now uses as default a Times New Roman font. You can use any
True  Type font  on your system.  Style  can  be changed,  size  is  ignored.  The
selected font is used for Display and Printing.

You can change the Font that is used from the Options menu.

Select Fonts and then use the dialog box to select a suitable font.
Depending  on  your  monitor  resolution,  some  fonts  will  display  better  than
others.  If  you  are  using  standard  VGA (640  X  480)  then  stay  away  from
decorative fonts. Plain fonts like Arial seem to work well.



When is a wine suitable to drink ? 1.5

Wines suitable to drink NOW, (and how to find them)

WBfW has a search function that finds all wines suitable to drink this year. It is
assigned to the button on the WineBar that has a 'Pouring Bottle and Glass'
on it.

Clicking on this button leads to this dialog.

 

All Wines To list all wines in your cellar 'at their best' click on the All Wines button.

By Variety The program also allows you to narrow the search down to a particular variety
of wine. Click on any of the varieties shown in the scrollable list which shows
all  varieties  in  your cellar,  and then click  the  by Variety  button (or double
click a Variety).

BestAt Tolerance Picking just one year as the 'best year to drink' for a wine is a bit fine,  so
WBfW includes the ability to use just the BestAt date or a range of years based
on the BestAt date and the spread between the GoodFrom and GoodTo dates.

ie A red wine with a cellaring potential of 20 years will have a bigger spread
than a white wine with a useful life of only 5 years.

You have a choice as to how you set this up.

The  default  is  an  'Auto' setting,  which  uses  the  spread  of  years  between
GoodFrom, BestAt and GoodTo dates to determine a suitable range of years.
Unless you have a particular reason for narrowing the search down to a Single
year or One year either side of this year, it is suggested that you use the 'Auto'
setting.

The  'Single Year' setting will only list wines that have a BestAt date of this
year. The 'Plus Minus One' setting will give you a spread of three years with
this year as the centre value.

You can  select  the  BestAt  Tolerance  from this  dialog,  or from the  Options
menu which has a selection called 'Best At' Tolerance, which has three further
selections of Single, PlusMinus and Auto.



When is a wine suitable to drink ? (cont.) 1.6

'Maturity Curve' The range of years is shown graphically on the Page Display of a wine, by a
row of glasses under the maturity graph.

 

Any wine  where the  current  date  line  intersects  the glasses is deemed to be
drinkable, with the Auto setting giving the best indication.

Danger + Decline As  searching  for  wines  that  have  already  reached  'Danger',  gives  little
indication of wines that are about to reach this stage, the options menu has a
selection  marked  Danger  +  Decline.  When  you list  all  'Danger'  wines  (Red
Bottle on the WineBar), all wines in the last stage of decline are listed as well.
The last  part  of the  decline  area  in the  above graph will  have  a red shaded
region when this option is on.

The 'BestAt' in future years graph

This is another area where the spread of years that a wine is drinkable has to be
considered. This graph uses the BestAt date to determine how many Wines and
Bottles will be 'at their best' in future.

Because it uses a single year and ignores the fact that a red wine 'at is best' in
the year 2000, with an expected life of 25 years, will be just as suitable in 1995
and 2005. So it is possible to have two towering peaks at 2004 and 2006 with
an apparent hole at 2005.

That hole might not be there, in fact I guarantee it isn't, because with so many
wines 'at their best' each side of it, most will be just as good the year after or
before, so filling the hole.

'BestAt' for a Variety To help determine if these holes exist, and as an aid to planning your cellar, the
BestAt  graph has been  extended to be able  to  plot  a single variety  of wine.
Select a Variety from the scrollable list.

 



Installing WineBase for Windows 2.1
What's on the disk The disk contains the 15 files that WBfW needs to run.

· WBFW.EXE SFX Archive containing main program file.
· WBGB.EXE SFX Archive containing GoldBook Data.
· WINELINK.DLL Used by the main program.
· WBHELP.HLP SFX Archive which contains the Windows help file.
· DLL.EXE SFX archive containing the various DLL's WBfW needs.
· MAP&FILE.EXE SFX archive which contains Maps, Sample and Winery Files.
· WBMANUAL.EXE SFX archive which contains Word for Windows .DOC files.
· README.HLP Latest information on the program.
· README.TXT Because everyone looks for one.
· EXPAND1.BAT Expands the Archived Program files (used by DECANT).
· EXPAND1.PIF Runs EXPAND1.BAT in a Window.
· EXPAND2.BAT Expands the Archived Document files (used by DECANT).
· EXPAND2.PIF Runs EXPAND2.BAT in a Window.
· DECANT.EXE Copies files and Installs in Windows Program Manager.
· THISFILE.WBS For people upgrading from versions prior to v1.9

DECANT.EXE

This is a Windows Application that ...

· Creates a directory (C:\WINEBASE is the default and recommended).
· Copies all the files on the floppy disk to this directory on your Hard Disk
· Expands the archived files and then Deletes the Archives
· Creates a Program Group in Program Manager
· Installs Icons for Program and the Documents
· Runs WineBase

You can install just the program files if you do not require a manual and select what directory Winebase is 
installed in.

First time installation

1. From Windows Program Manager
2. Select Run from the File Menu.
3. Type A:\DECANT in the Command Line Edit field (or B:DECANT if your 3.5" drive is B:)
4. Click on OK or press the ENTER key to run DECANT.
5. Click on Continue to Install WineBase

Upgrading to a Registered version or Updating to a later version

1. DO NOT DELETE ANY FILES FROM THE WINEBASE DIRECTORY
2. Run DECANT as for first time installation.
3. Make sure that the Directory matches where Winebase is currently installed.
4. When the files are expanded, answer YES to all prompts of "Replace this File".



Installing WineBase for Windows 2.2

First time its run The first time you use the program it will inform you that it cannot
find  the  Data,  Schedule  or  Note  files.  You  will  be  prompted  to
create these files. 

Click on Yes or OK.

WBfW will create eight blank data files called...

WINEBASE.DTA Main data file.
WINEINFO.DTA Your information sheet.
NETWORTH.DTA For Value and Stock graph.
WINENOTE.DTA Comments file for each wine.
SCHEDULE.DTA Tasting Schedule for each wine.
MAPFILE.DTA Cellar Mapping for each wine.
MYCELLAR.DTA Rack layout file.
RACKFILE.DTA Cellar rack definitions.

This takes a second or two.

If  the  preferences  file  INTNAT.WBS is  missing  then  a  file
containing default values will be created.

A Transaction File [Month][Year].PAU will also be created.

You will  also be presented with a Dialog box asking you to enter
details about your winery. If you are using WBfW to manage your
own home cellar, you can ignore this Dialog. If you choose 'Save this
File'  or  'Exit,   without  filling  in  any  fields,  a  blank  file  will  be
created. Its password is CR (carriage return or Enter). This file is not
used when you are looking at 'Your Cellar',  but it must be present.
You  can  edit  this  information  file  from  the  Files  Menu  /  Make
Winery Files / Edit  Winery Information File,  option when you are
using 'Your Cellar'.

If  WINEINFO.DTA goes  missing  at  any  stage,  the  above  process
will be repeated.

If you are a Winery, and wish to create Data Files of your products,
please fill  in the fields with the relevant information. This topic is
covered further in section 4.2 Make Winery Files.



Adding a new wine / editing a wine 3.1

The EDIT Window All new files are entered and existing files modified by using the one
Window (or Dialog Box). This is called the Main Edit Window. 

To add a new wine Select  Edit / Add a New Wine... from the main menu bar, or click
on the 'Plus' button on the 'WineBar'.

To modify an existing wine Select  Edit  /  Edit  existing  Wine from  the  main  menu  bar,  then
Right Click on any wine listed in the INDEX listing.

You can edit any wine from any Index listing.

This  Dialog  remains  on  the  screen  until  you  click  on  Cancel  or
Finished Adding Wines

 

Fill in Vintage first If you fill in the Vintage field first, followed by the Variety, then the
Good From, Best At, and Good To dates will be filled in with default
values for that wine. These are only a rough guide. Edit to suit your
needs. If you change the vintage , these dates will be updated once a
Variety is selected.

Lookup GoldBook If you have the GoldBook for WBfW you can use the data from the
book to fill in the Good From, Best At, and Good To dates, as well
as  Value,  Ranking  etc.  In  order  to  use  this,  you  have  to  enter  a
Vintage, Winery and a Variety (and maybe a Label) that matches the
entries in the book. If the wine is found a Dialog Box will show the
search results, and give you a choice as to whether to use the values
supplied.

Non Vintage Button Next  to  the  Vintage  scroll  arrows  is  a  button  marked  NV. When
clicked,  9999  is  placed  in  the  Vintage,  Good  From,  Best  At  and
Good To date fields. This signifies that the wine has no vintage (ie a
fortified wine that has no definite shelf life) and is treated as such in
all  Listings,  Graphs  and  Tables.  In  the  scrollable  display  screen
wines of this type are marked as NVin (which is shown in blue, as is
the Age box). In graphs and tables there is a separate column on the
left hand side marked Nv. In the full screen display mode the vintage
will  be  listed  as  'Non Vintage'  and  there  will  be no ageing  graph
shown.



Adding a new wine / editing a wine 3.2

Drop down Lists Besides  the  Winery,  Label,  Region,  'User1',  'User2'  and  Cellar
Location  Edit  Boxes  are  down  arrows,  when  clicked  on,  these
produce a drop down list of all current Wines in your cellar. Click
on anyone to select and place in the Edit Box.

Cross Reference Files Next to the Winery Edit Box are additional buttons marked List and
Find Region. The List button presents you with a Dialog Box with
Wineries listed. Current entries include Australia, France, USA and
Germany. When you select one of these by Double clicking on it or
Single clicking and pressing Enter or clicking on OK. This Winery
is placed in the Winery Name field and the Region is placed in the
Region Field.

If  the  Winery  Name  field  is  filled  in  manually,  then  clicking  on
Find Region will update the Region field. If the Winery Name does
not match anything in the list, a ? is entered.

'User1, User2' Fields You  can  change  the  title  of  both  these  fields  using  the  File  /
Preference  option.  You can Search on this field.  Suggested other
choices are 'Supplier', or 'Food'. Using 'Supplier' you could list your
wines  according  to  where  you got  them.  'Food'  could  be  used  to
cross reference  wines that  go well  with various foods.  You could
then  Search  on  a  particular  food  and  all  wines  that  are  suitable
would be listed. 

See also Section 5.5 Being Creative.

Selecting Wine Varieties To select a Variety  use the scroll arrows to browse the list and left
click on the required one. The list contains the 33 predefined types
and any that you might have added. The selected choice will appear
above the List Box. 

Adding new Wine Varieties Next to this is a button marked  Add New Variety, if you click on
this the  Add new Wine Variety  Dialog Box will appear.  You can
enter  any type you like  in the  Edit  Box.  Click  Add to place  your
selection  in the Grape Variety / Wine Class Edit  Box in the main
Edit Screen. The List Box is also updated, but you must save the file
with this Variety to store it.

 

With any custom Grape Variety or Blend that  you enter  the Good
From, Best At, and Good To dates will be set at default  values of
2,3,5.  Edit  these  based on your (or  someone  else’s)  knowledge  of
that wine.

Deleting a Wine Variety You can delete the 33 pre defined Wine Varieties from the list, using
the Preferences option on the Options Menu.



Adding a new wine / editing a wine 3.3

Notes, Tasting and History The group of buttons below the Variety field allow you to edit the
additional files for each wine.

Notes The Notes button leads to a Dialog where you can enter eight lines
of text. You can enter any detailed information on the wine in this
file. Each line is a separate field, and you can use the TAB key to
move down the fields.

Tasting Schedule WBfW includes the ability to 'Flag' a wine for tasting. The Tasting
button, brings up the following Dialog Box.

You can also access this directly from the TimeLine.

 

This has eight lines of three fields. The first two are for the Month
and Year. These must be a number...

ie. 6   1996

The third field is for any notes, and are best entered after the wine
has been tasted. There is not much point in putting in something like
"Taste this now" when you enter the dates.

An empty notes field is used in conjunction with a month and year
that  is prior to the current  date  to find "Wines that  have not been
Tasted".

When you search for wines that are due for tasting, by clicking on
the 'Two Tasting Glasses' button in say the month of March 1994.
The entire cellar is searched and any tasting note entries that match 3
1994, 4 1994 or 5 1994 are listed.

You can  also  search  for  wines  that  have  not  been  tasted  (or  you
forgot  to  comment  them).  You can  also print  this list,  and tasting
notes are printed along with general notes when you print the Page
Display of a wine.

History The  History button lists the 'History Fields' for the Wine, at which
point you can Edit them. A new wine has no History, so you cannot
edit it.



Adding a new wine / editing a wine 3.4
Detailed Notes You can attach a text file of up to 8000 characters in size, to each wine via the

Page Display Screen. Select Text File from the Menu Bar. If the file exists it
will be displayed, if not, a new blank file is created. You can use Cut and Paste
to exchange data between the Windows ClipBoard and this file.

Purchased Clicking on  Add Date enters the current system date in the Purchased field.
You can also use this field for the 'Supplier' of the wine and add the date to the
end. Suggest you use short date format 

Bottle Price You can enter the price in any format you like,  WBfW strips any characters
out, and uses only the numbers for calculations, but it displays what you enter
when listing wines.  The default  value  is  $10.00 and you can  change this in
steps of one by using the scroll arrows. You must enter at least one digit, even
if its a zero. The button to the left of the scroll arrows enters a price of $0.00
which will be displayed as ? in the Index Window.

Value For the  current  market  value  of  the  wine.The  small  button  with a  '>'  on it,
between the Price and Value fields places the Price in the Value field.

Stock 1 case = 12 Bottles.
Default bottle size is 750 ml.
Maximum bottles = 251 (20 cases and 11 bottles).

If you have 32 bottles of a Wine you would enter this as ...

2 Cases + 8 Bottles =  32 Bottles Total Stock.

Cellar Location The INDEX page only lists the first  seven characters  of the Cellar  Position
field. Therefore choose your descriptions accordingly. Eg. BULK, RACK 12,
Ra3Sh11 (Rack 3 Shelf 11) etc.  If you wish to sort on this field you need to
make each entry the same length, or pad numbers with leading zero's.

ie A01 .. Z99 or AA001 .. ZZ999 will sort, while A1 .. Z99 or A1 .. ZZ999
will not.

If you use Cellar Mapping leave this field blank.

Map Button WBfW allows you to store  the  same wine  in  up to  four different  locations
using Cellar Mapping.

This topic is covered in full in sections 8.1 and 8.2.

Entering similar Wines Because this Dialog stays on the Screen after you click on Save this Wine, you
can edit  any of the fields (such as Vintage and the Good From, Best At and
Good To dates, or the Location) and click on Save this Wine again.

Save this Wine Saves the current information.

Finished Adding Wines When you have finished adding new Wines to your cellar, click on this button
to close the Main Edit Dialog.

Deleting Wines You can delete a Wine from the Page Display Screen. List the required wine
in an Index listing, left click to display the Page Display and then Delete it.


